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1. INTRODUCTION TO gvSIG 
 

gvSIG is a project that arises by initiative of the 

Valencian Generalitat, through the Conselleria d’ 

Infraestructures i Transport (public tender "Computer services 

for development of GIS applications for the Conselleria d’ 

Infraestructures i Transport using free software."). 

The Jaume I University is in charge of monitoring that the development follows all 

the international standards (Open GIS Consortium). 

IVER Tecnologías de la Información, the company awarded with the tender, is 

responsible for the development. 

1.1  What is gvSIG?   
 gvSIG is a tool oriented to manage geographic information. It is characterized by 

a user-friendly interface, with a quick access to the most usual raster and vector formats.  

It integrates local and remote data in the same view through WMS, WFS, WCS, and 

more sources.  

It is aimed at end users of geographic data, whether professionals or civil 

servants (city councils, councils, regional councils or ministries). It is highly interesting for 

university settings due to its R&D&I component. 

The application is open code, licensed as GPL and free. In addition, special 

emphasis has been placed on the expansion of the project so that potential developers 

can easily expand the functions of the application, as well as develop completely new 

applications from the libraries used in gvSIG (as long as they comply with the GPL 

license). 

1.2  What can we do with gvSIG? 
gvSIG is a sophisticated GIS for managing spatial data and performing complex 

analyses on them.  
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With gvSIG you can perform different tasks, like the following: 

1.3   gvSIG’s interface  
The Interface of gvSIG provides the necessary features to communicate with the 

program. The graphical interface of gvSIG is intuitive and easy to use, within reach of 

any user familiar with Geographic Information Systems (GIS). 

gvSIG’s interface consists of a main window with different tools and secondary 

windows for the documents created with the program, as described in the following 

sections. 

Before describing the different documents and tools, it is necessary to learn the 

interface of gvSIG, the more familiar you become with its interface, the easier it will be to 

go through the following chapters. 

 

 

 

 

 

 

 

 

 

1 Title bar: located in the upper part of gvSIG's window. It contains the name of 

the program, in this case "gvSIG". 

2 Buttons: to maximize or minimize the active window of the program, or to 

completely close it. 

3 

4 
5 

6 
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3 Main window: Work area, where you can find the different windows that show 

the "Project Manager” and the different gvSIG documents. 

4 Menu bar: Here you can find grouped in form of menus and submenus some of 

the functions that gvSIG can perform. 

5 Toolbar: it contains the icons of the most usual commands. It is the easiest 

way to access them. Click and drag the Toolbars to move them from their initial position 

to have them floating. It is not necessary to memorize the meaning of all icons, when 

you position the mouse pointer on them, a message will immediately appear with the 

description of its function. It is just a box with quick information. 

6 Status Bar: it provides information on coordinates, distances and similar 

elements. 
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2.  gvSIG PROJECTS AND DOCUMENTS 
 

In gvSIG all the activity is located in one project, which is formed by different 

documents. There are three types of documents in gvSIG: Views, tables and maps. 

 

 

 

 

 

• Views: are the documents where you work with the graphical databases. 

• Tables: are the documents where you work with the alphanumeric 

databases. 

• Maps: map generator that allows to easily inserting the different cartographic 

elements of map. 

The projects are files with the extension ".gvp". This file does not contain the 

spatial data and attributes associated in form of tables, but it stores references to the 

place where the sources of the data are kept (the path to follow in the disk to reach the 

files). If data are changed, the updates will be shown in all the projects where they are 

used. 

2.1  Saving a project 
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1. In the Menu bar, click "File" and then "Save project". Another option is 

to press the shortcut keys "CTRL + G", or click the Save button. 

2. When you open the file manager window you can establish the name 

of the project and the folder where you will save it.  

 

3. The project is saved in a file with the extension ".gvp". 

2.2  Opening a project 
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1. If you want to open an existing project to see or modify it, go to the 

menu "File" and click "Open project". Another option is to press the 

shortcut keys "CTRL + A" or click the “Open project” button. 

2. The file manager window opens, and then looks for the ".gvp" file that 

contains the project that you want to open. 
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3. VIEWS  
The views are the documents of gvSIG used as the work area with cartographic 

information.  

A view may contain different layers of geographic information (hydrography, 

communications, administrative divisions, level curves, etc.). Each theme is a "layer" of 

information. 

 

 

 

 

 

 

 

 

 

 

 

When you open one of the views of a project, a new window appears divided into 

the following components: 

1 Table of contents: located in the left side of the window or screen of the View. 

The Table of contents lists all the themes that it contains and the symbols used for the 

representation of the elements of the Theme. 

2 Map windows: located on the right side of the screen of the View. It is where 

the cartographic data of the project are represented. 

1 

2 

3 
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3 Locator: located on the lower left side. It allows locating the current frame in 

the total of the work area.  

The main window, when you open a View, increases the number of menus and 

buttons, and adds the tools that allow working with the elements of the View. 

The size of the Table of contents can be enlarged by dragging its edge to the 

right with the mouse, in order to completely visualize the description of the themes. 

3.1  Creating a view 
1. In the Project manager window select the document "Views". 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 
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2. Click on "New" button.  

 

 

 

3. A view is immediately generated, which appears listed in the box of "Existing 

Documents". By default it appears as "Untitled  – 1". 

 

    

 

 

 

 

 

 

2 

3 
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4. You can change the name of the View by selecting the document and clicking 

the “Rename” button. 

 

 

 

 

 

 

 

 

5. A dialog box opens in which you can change the name of the View. 

 

 

 

 

 

 

 

 

 

 

 

4 
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6. The following step consists in setting up the properties of the View. It is very 

important to select the units of the cartography and the units of distance that 

you will use for that view (by default they are expressed in meters). In 

addition you can configure the background color (by default it is white). From 

version 0.3 of gvSIG, the views support different projections and reference 

systems. Select the coordinates system (Datum and projection) where you 

are going to view the cartographic information.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6 
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7. The menu of reference system change allows you to choose from the most 

frequently used reference system, such as WGS84 or ED50. In addition, it 

allows you to choose between visualizing the information in geodesic 

coordinates or according to a given projection.  

 

 

 

 

 

 

 

 

 

3.2  Table of contents 
As mentioned above, the Table of Contents is the area where the different 

Themes or layers that constitute the cartographic information are listed. 

A checkbox next to each theme or layer indicates if it is "visible" or not, that is, if it 

has been drawn or not in the visualization Window. 

It is not the same to activate a theme than to make it visible. When a theme is 

activated it appears highlighted with respect to the rest of Themes of the Table of 

contents. When you activate it, gvSIG is notified that you can work with the elements of 

that Theme. 

The order of appearance of the Themes in the View is important. The themes that 

appear in the upper part are drawn on those that appear below. For that reason, the text 

elements, point and linear should have to be kept in the upper part, leaving in the lower 

part the polygonal themes and images of the background of the view. They can be 
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moved by clicking  the mouse button on them and holding it down place them in the 

desired position. 

 

 

 

 

 

 

 

Since version 0.4, gvSIG allows to group several themes in a set. This is useful 

when the TOC has a lot of themes because it saves screen space and also allows to 

perform operations over every theme in the set at once. 

To group a set of layers you only need to select them keeping Shift-key pressed. 

Then, right-click over any of the selected layers with the Shift-key pressed. A dialog will 

appear. Select the Group Layers option. 

 

A new dialog will appear, choose a new for the new group. 

 

Active Theme 

Visible Theme 
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Once the name is set, the new group will appear in the TOC as it is shown in the 

next picture. 

 

 

 

 

 

 

 

 

Any change applied to the group will affect to the features of the themes that form 

it. 

To remove a group, just right-click on it and select the Ungroup option. 
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3.3  Data sources for the Themes 
Within a View you can add different types of Themes or layers of cartographic 

information. You can load vector or raster files, and a large variety of formats of these 

types. 

• GIS Data: the standard format of the GIS data is shape, which stores 

spatial data as well as their attributes. Shapes (also called "Shape files") 

although from gvSIG they are handled as a single file, in fact consist of 

three or more different files with the same name and extensions: 

o Dbf: Table of attributes. 

o Shp: Spatial data. 

o Shx: Index of the spatial data. 

There are three types of shape files, depending on whether they represent 

polygonal, linear or point elements. Different types of elements cannot be 

represented in the same shape. 

Version 0.5 of gvSIG also includes the characteristic to access Postgis 

and MySQL spatial data bases through a new driver that uses JDBC. 
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• CAD Data: they are vector drawing files. The supported formats are dxf 

and dgn. CAD Files may contain information of points, linestrings, 

polygons and texts. Since v0.4, gvSIG supports to access to information 

contained in Autodesk’s DWG 2000 files. 

• WMS Data (Web Mapping Service): with gvSIG it is possible to look up 

WMS data, that is, data available from the Web. 

• WFS Data (Web Feature Service): since version 0.5, gvSIG download 

vector layers from this kind of servers. 

• WCS Data (Web Coverage Service): since v0.4, gvSIG supports to 

access to remote information through Open Geospatial Consortium’s 

WCS Protocol. 

• Images: gvSIG can visualize files of different raster images (tiff, jpg, ecw, 

mrsid, etc.). Since v0.4, it is possible to save modified images in one of 

these formats. 

There are also new features related to the creation of raster layers. In this 

new version you can open raster files such as "color palette" (GIFs, 8-bit-

PNGs, etc.) and you can open raster files without georeference. In 

addition, this new version supports GIF, BMP and JPEG2000 formats. 

3.4 Adding a Theme 
 

To add themes (or layers) go to the “File” menu and select “Add Layer” or press 

Ctrl+O when a View window is active to open the “Add Layer Wizard”. 
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Choose the data source of the layer according on its type: 

 
 

 3.4.1.- Data stored in local drives 
 

In the case of the local files, if you click on the Add button, the file manager 

window will open and you will be able to look for and select the theme that you want to 

add to the view. In the lower part you can choose the type of file to load. From version 

0.3 of gvSIG it is also possible to choose the reference system and the projection of 

each theme. 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

The Open dialog allows browsing the file system and selecting a theme to load. 

Keep in mind that the files are filtered up on the selected driver. To set the file type, 

select it from those contained in the combo box. 
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 3.4.2.- WMS Data sources 
 

Following the gvSIG’s philosophy of implementing open spatial data accessing 

protocols, it includes an OGC’s WMS (Open Geospatial Consortium, 

http://www.opengeospatial.org). In the 0.6 version, the client has been improved and 

supports many new features. 

For instance, accessing to the styles of the layers that the server holds is now 

possible. Furthermore, the previous versions did not allow the user to edit a WMS layer 

once it was added to the view. This lack has been solved and now it is possible to 

change the layer properties as well as the local layers do. 

 

3.4.2.1 Creating new layers 
 

Open or create a new gvSIG view where to add a WMS Layer and click on the 

“Add layer” button. The “Add layer wizard” is shown where you can see the WMS tab. 
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The picture shows the add layer wizard. You can add a WMS layer from the 

WMS tab. Select or type in the combo box the server that you would like to connect to 

and press the Connect button. Once the connection is established, the server’s 

description appears. The connection version is shown in the bottom text. Press Next 

button to start setting the new WMS layer. 
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3.4.2.2 WMS Info 
 

The first page of the WMS wizard is the information page. It shows the summary 

or the current settings of the WMS request (service info, formats, coordinate reference 

systems, selected layers, and so on). This page is refreshed each time the settings are 

changed. 
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3.4.2.3 Layers selection 
 

The next page shows the layer tree hold by the WMS server. 
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Select those layers that you would like to add to your gvSIG view and click the 

Add button or double-click on them. If you want, you can specify a custom name for your 

new layer in the field Layer Name. 

 

Note: you can select more than one layer by keeping the Control key pressed when 

clicking with the mouse. 

 

Note: a description of the layer will appear if you place the cursor over a layer and wait 

a little. This description shows the info given by the server for its layers. 

 

 

 
 
3.4.2.4 Style setting 
 

The Styles page allows choosing the desired style for the previously selected 

layers. The Style property of a WMS layer is optional so, it is possible to find this page 

disabled. The most of cases this is because the server does not defines any style for the 

layers that have been selected. 

 

 

To mark the style, just click on it. 
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3.4.2.5 Selecting values for the dimensions in a WMS layer 
 

The Dimensions page will help you to configure the value of a concrete 

dimension of the selected layers. The Dimension property is, like the Style on, optional 
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as well. So, it is possible that this option remain disabled if the server does not specify 

any dimension for the selected layers. 

 

 
 

 

Initially, no dimension is defined. To add one select it from the dimension list in 

the settings edition area. 
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The bottom-right edge controls will be enabled. Use the slider to fast browsing 

the values defined by the server for the selected dimension or use the fast backward, 

backward, forward and fast forward buttons to move to the beginning, step back, step 

forward or move to the end of the list respectively. Even more, if you already know the 

position of the value desired, just type it in the text field and automatically you will be 

moved to it. 

 

Click on Add to copy the selected value to the text field. Depending on the kind of 

value you selected (simple, multiple or interval value) the value selected will replace, will 

be added to the list, or will define the ending point of the interval requested to the server. 

 

Once you have the expression that defines the values that you’d like to request 

click on the Set button and it will appear in the info panel. 

 

NOTE: although each layer can define its own dimensions, only one value (single, 

multiple or interval) per dimension is allowed. It is possible that the value selected is not 

defined for any of the layer set that has been defined for the request. Due it is possible 

to use a value for a dimension, i.e. a value for TIME, which is not supported by one or 

more of the selected layers. If so, you’ll probably get an error message from the server. 

 

NOTE: it is possible to use a custom expression in the text field. The controls in the 

dialog are designed solely to make the edition of dimension expressions easier and you 

can gain manual control at any time in the text field just clicking on it. 

 

 
3.4.2.6 Setting format, coordinate reference system and transparency 
 

The formats page will allow you to set the format of the image to be retrieved, 

specify if you want the server to deliver the image with transparency (only for formats 

that support it) in case you want to overlap the layer over the other layers already 

present in the gvSIG view. 

 

  You can also set the coordinate reference system in which to request the layer. 
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3.4.2.7 Adding the layer to the view 
 

The format, the SRS (the coordinate reference system) and the list of layers to 

retrieves are values that must be defined. The wizard will not allow you to add a WMS 

layer until it does not have enough info to send a right request and the Ok button will 

remain disabled to avoid errors. When the settings are enough then the Ok button will be 

enabled. Click on it to add the new WMS layer to the view 

. 
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3.4.2.8 Editing the properties of an already created layer 
 

Once a WMS layer is added to the view it is possible to edit its properties. To do 

so, go to the layer tree in the table of contents (TOC) of your view in gvSIG and right-

click over the WMS layer that you’d like to fit. Select the WMS Properties entry from the 

floating menu that appears. 
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The Fit WMS layer dialog will appear. Operate it in the way you did in the wizard. 

 

3.4.3.- WCS data sources 
 

Other OGC service supported by gvSIG is WCS. To add a layer of this kind use 

the WCS tab from the “Add layer” wizard. Pick or type a WCS server in the combo box 

and then press the connecting button. 
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Click the next button to see the available info and the download options. 
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As in WMS, browse the tabs and select the options to obtain the coverage. When 

the wizard has enough information to perform a request correctly, then the “Ok” button is 

enabled and the layer is created in the active view.
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3.4.4.- JDBC data sources 
 

This option allows us to load a theme/layer from a JDBC database server, such 

as PostGIS and MySQL Spatial coverages. 

First, go to the JDBC tab in the “Add layer” wizard and name the new connection. Then 

specify the hostname (or the IP address), the port in which the server is listening for 

connections, username and password for the database, the catalogue name (for 

Spanish speakers the catalogue name should be written using latin1 codepage), and the 

driver to use for the access (currently we can choose among PostGIS, MySQL or 

HSQLDB drivers). 

 

 
 

When you click on the "Next" button, the tables or layers available in the selected 

catalogue will be displayed. You can also select only one portion defined for one area. 
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When you click on the "Next" button, the fields available for the selected table will 

be displayed. You can select one, several or all the fields. 
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When you click on the "Next" button, a menu will display and you can select the 

field that contains the geometries. 
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When you click on the "Next" button, a menu will display and you can select the 

field that contains the unique identifier. 
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When you click the "OK" button, the coverage from the data base will be displayed 

as another layer in the TOC. 

 

3.5 Exporting a Theme to PostGIS 
 

You can export any vectorial theme to PostGIS by clicking on the option Save 

layer in PostGIS of the Layer menu. 
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gvSIG will then request a name for the connection: 

 

Once you have assigned this name, the following dialogue box will appear, and it 

will allow you to configure the connection: 

 

If all the information is correct and you have the required permissions, it will then 

export the information: 

 

The sequence will conclude with the following message: 
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If the process has concluded successfully, you will have exported the information 

contained in your vector layer to a table in a PostGIS data base. 



gvSIG – User’s Guide                                

 

 

March 2006  Page 44 of 106 

3.6 Add Event Theme 
 

1. The add event theme command. 
This tool allows creating new layers into a gvSIG’s project from a gvSIG’s table. 

The data source for this table can be one of those currently supported by gvSIG. 

It is interesting to highlight that plain-text format files, such as comma-separated, dot-

separated values files are also supported. 

Once a table has been loaded, execute the “Add event tool” to create a new point 

layer. This new layer will appear in the view’s TOC. The coordinates for these points are 

obtained from the table. The fields used for the X and Y axes will be specified by the 

user in the dialog 

2. Input data for the “Add event theme” command. 

Firstly, a table must be loaded from several sources: dBase (DBF), comma-

separated value ASCII files (CSV)… 
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With the table loaded into the Project we can proceed executing the “Add event 

theme” tool. 

 
3. Where is the Add event theme command? 
 
Once the table is loaded and a view is active a new icon appears in the tool bar. 

 
 

 
 

4. Executing the “Add event theme” tool 
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Click on the icon and the configuration dialog will appear. Set the source table 

and the fields to use as coordinates for the X and Y axes. 

 

 
 

Then click on the “Ok” button and the new vector layer will be created based 

upon the coordinates in the table. 

 

 

 

3.7  Navigating/Exploring the map 
There are several tools to navigate through the map that basically consist in 

zooms (changes of the visualization scale) and movements. 
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Zooms and Scrolls 
These tools can be "executed" from the View menu or, even faster, from the 

button bar. 

 Zoom in: it enlarges a given area of the View. 

 Zoom out: reduces a given area of the View. 

 Pan: it allows changing the frame of the view by dragging the field of 

visualization in all directions with the mouse pointer; hold down the left button and 

move the mouse towards the direction desired. 

 Full Zoom: It zooms to the total extension that defines all the themes of 

the View. 

 Previous Zoom: It allows returning to the previous zoom. It allows back up 

to four frames. 

Zoom to Theme: If you click the right button of the mouse, a floating menu 

appears in which you have the option to "Zoom to Theme". It zooms the image to 

the extension of the theme. 
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 Zoom to selection: It zooms to the total extension that defines all the 

selected elements. 

Control of scales: when you click on the Layer menu -> Properties, you enter 

the Theme Properties menu. Once here, from the Visualization tab you can limit 

the scale at which you will visualize the Layer. 
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Managing Fit in 

 When you click on the Managing Fit in button you can record a given work 

area, in order to return at any time to this frame. When you perform this action the 

window "Managing Fit in" appears, from which you can save, load or delete the different 

frames or work areas. 

 

 

 

 

 

 

 

 

 

 

3.8 Legend Editor 
Data can be represented in many different ways by means of the Editor of 

legends of gvSIG. It is a tool that allows you to make thematic cartography quite easily. 

In order to symbolize or represent the data or variables of the elements of a given 

Theme you can choose the adequate color, pattern, etc. for each one of them. 
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If you click the right button of the mouse on the Theme, a floating menu appears 

in which you have to select the Properties option to edit the symbol. 

 

 

 

 

 

 

The Properties menu has two tabs, one describing the theme’s general properties 

and another describing the properties related with the symbol. In the second one is the 

menu that handles the legend. 
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Within this menu we can define the legend that we want to use to represent the 

data about a theme. 

We can choose one of the following representation flavors. 

• Single Symbol: Default gvSIG’s legend type. This legend type represents 

every element of a theme using the same symbol. This is useful when what 

we need is to show the location of a theme rather than any of its attributes. 

• Single Values: It is possible to represent each record with an exclusive 

symbol according on the value contained in a field of the table.  Useful to 

show categorical data like towns, ground types, etc. 

• Intervals: This kind of legend represents the elements of a theme using a set 

of colours. The Intervals or degraded colours are mainly used to represent 

numerical data that has a progression or a set of values like population, 

temperatures, etc. 

• Labelling: Allows to automatically adding texts or labels to the view 

depending on the values that each element has in a specified field in the 

table. 

 

The options shown in the symbol menu depend on the theme’s type (points, 

lines, or polygons). Let’s see the options shown for a polygon-type theme, which 

is the one with more options. 

We can load and save a legend at any time.
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Unique Symbol 

. 

 

 

 

 

 

 

 

 

 The following options of symbol configuration are available: 

1 Fill: it allows selecting the type of color (from the windows Change Color); if 

you activate the option "Type of fill" you can define the pattern of the fill. 

2 Line shape: it allows selecting the type of color (from the Change Color 

windows); if you activate the option "Type of Line" you can define the style of the line. 

3 Synchronize the color of the edge with the color of the fill. 

4 Line thicknesses: it allows defining the line width.  

5 Transparency: it allows adding a degree of transparency to the elements. This 

option allows having the polygon themes superposed to others of any type without 

preventing its visualization. 

6 Preview: it allows to immediately seeing the result of the changes you have 

applied.   

1 

2 

3 

4 

5 

6 
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Unique Values 

 

 

 

 

 

 

 

 

 

The following options of symbol configuration are available: 

1 Classification field: it opens a drop-down menu in which you can select the 

field of the table of attributes of the theme that contains the data to be sorted. 

2 Add all / Add: when you select "Classification field", by clicking on the "Add 

all", it shows all the different values, assigning a different symbol (color) to each one of 

them. These symbols can be modified by clicking on them. By default, the label (name 

that appears in the legend) is similar to the value it takes in that field. Click on the “Add" 

button to include new values to the list. 

3 Remove all / Remove: it allows deleting all (remove all) or some (remove) of 

the elements of the legend. 

4 Labels: Click the left button of the mouse on any of the "Label" cells to modify 

the name with which it will appear in the legend. 

 

1 

3 2 

4 
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Intervals 

 

1 Classification field: it shows a drop-down menu in which you can select the 

field of the table of attributes of the theme to perform the classification. The field has to 

be numerical, since it is a gradual classification (by ranks of values). 

2 Number of Intervals: Enter the number of ranks or intervals that define your 

classification. 

3 and 4 Start color and final Color: select the colors that will be used to carry 

out the graduation. The initial color for the lowest values and the final for highest. 

5 Compute intervals: once you have defined the previous options click the 

"Compute intervals" buttons to see the final result of the legend. As in previous cases, 

the symbols and the labels that appear by default can be modified if you click on them.  

6 Add: You can add new ranks to those already calculated. 

7 Remove All / Remove: it allows to delete all (remove all) or some (remove) of 

the elements of the legend.  

8 Type of Intervals: Since v0.4, it is possible to specify the type of interval used 

to represent the information. We can choose among the following options: 

1 

7 6 

3 4 

5 

2 
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-Equivalent intervals: You need to specify the number of intervals in which the 

info will be split. 

-Natural intervals: Specifying a number of intervals, the info is divided in 

intervals using the Jenk method for interval natural optimization. 

 

-Quantile: Specifying a number of intervals, the info is divided in intervals but it 

is grouped depending on its order number. 

 

Labeling 

 

1 Enable labeling: if you activate the checkbox you can make the Labeling in the 

View visible or invisible. 

2 Labeling field: drop-down menu that allows you to select the field of the table 

of attributes of the Theme that contains the values to show as labels. 

3 Text color: it allows you to select the color of the text. 

3 

6 

1 

5 

2 

4 
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4 Font: it allows you to select the font. 

5 and 6 Fixed height of text: you can select the units (meters or pixels) and the 

size of the texts. If you select pixel, the height of the text will be fixed, even if you change 

the visualization scale; if you select meters, the height of the texts will vary depending on 

the scale you are using. 

3.9 Delete a Theme 
In order to delete a theme permanently from the View, click the right button of the 

mouse on "Delete layer" in the menu "Table of contents". 

 

 

 

 

 

You can delete several themes at once by keeping the shift key pressed. 

3.10 Locator 
The locator is a small-scale general-purpose map that is in the lower left side of 

the window of the document View and is used to locate the work area (zoom of the main 

Window). 

You can select any Theme to add it to the locator.  

1. In the Menu bar, click on "View" and selects "Configure locator". 

2. A window appears where you can add the layer or layers that will be 

part of the locator. From this window you can delete layers or edit 

their legends. 
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3.11  Information tool 

 Used for obtain data on the elements of the map. 

When you click on any element with this tool, gvSIG shows a dialog box with the 

attributes of this element. To do this, you should have previously enabled the theme of 

the element to identify (by clicking on the name of the Theme in the Table of contents). 

 

 

 

 

 

 

 

 

3.12 Measuring distances 

 This tool provides information on the distance between two points. 



gvSIG – User’s Guide                                

 

 

March 2006  Page 58 of 106 

In the first place, you should verify that the units of measurement have been 

established correctly (by default, meters). Note that the units are established in 

"Properties" of the View. 

In order to use the measurement tool, just click on the point of origin and move it 

to its point of destination; you can perform as many measures as you wish by double 

clicking to finish the action.  

The calculation of the distance measured is displayed in the lower part of the 

View window. It shows the distance of the last segment measured, as well as the total of 

segments. 

 

 

3.13 Measuring Areas 

 This tool provides information on a given area defined by the user. 

It works in a similar way to the tool "Measure Distances". Just click on the point 

that represents the first vertex of the polygon that defines the area to measure, and 

move the mouse and click on each new vertex, finally, double click on the last one. 

The calculation of the measured area is shown in the lower right part of the View 

window. 

 

3.14 Table of Attributes of a Theme 
All the themes of gvSIG have their associated tables of attributes. Each element 

(point, linestrings or polygon) of a theme has a unique record in the table of attributes of 

this theme. 



gvSIG – User’s Guide                                

 

 

March 2006  Page 59 of 106 

 When clicking on the button, it shows the table of attributes of the theme 

that is activated at that moment. The table of attributes describes the thematic elements 

of each element of the theme (alphanumeric data). 

 

 

 

 

 

 

 

When you activate this table, it will be listed in the Project window within the 

document Tables. 

 

 

 

 

 

 

 

 



gvSIG – User’s Guide                                

 

 

March 2006  Page 60 of 106 

3.15 Selection of elements 
There are different methods to select one or several elements: by graphical or by 

alphanumeric queries. The elements are selected in the graphic section (View), as well 

as in the alphanumeric part (Tables). 

1 The selected data are always shown in yellow in the View. 

 

1. By Point 

 This is the basic selection method, which consists in clicking on the element 

that we want to select. 

2. By Rectangle 

 It allows selecting the elements that are partially or completelly within a 

rectangle defined by the user. 

In order to define the rectangle, position the mouse pointer, with the left button 

pressed, in the place where you want to begin to draw the rectangle and release in the 

place that would be the opposite vertex.  

1 
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3.  By Attributes 

 gvSIG allows to make selective selections, by means of queries (filters); this 

allows to identify elements with specific characteristics.  

The selection by attributes allows to precisely define what to select, including 

several attributes, operators and calculations. 

The queries are performed by means of logic operators, such as "same as", 

"higher than", "different from", etc. 

 If you click on the "Filter" button of the Toolbar, a dialog box appears to enter 

your query. 

 

1 Fields: in the list of Fields of the theme double click on the field that you want 

to add to the query. 

2 Logic operators: they allow you to insert, by clicking on them, a logical 

expression to the query. 

1 

2 

3 

4 
5 
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3 Values: it shows a list with the different values of the selected field. 

4 Query: the window where the query to be performed is being represented. You 

can enter it directly. 

5 Selection buttons: They perform the query by making a new selection 

(clearing any previous selection), add the elements selected by the query to the 

previously existing ones, or perform the query on the elements already selected. 

 

4. by Theme 
 

Go to View menu, selection by theme. The selection by theme dialog will appear.  

We can set here the selection over an active theme, based con topological criteria. 

 

5. Clear selection 

 If you click this button all the elements selected are cleared. 

 

 

6. Export selection 
If you click Layer, Export selection, you can export the selected elements to a 

new Shape file. 
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In the menu "Save as",  you specify a file name and you obtain a new Shape file 

with all the selection.  

 

  

3.16 Hyperlink 

 By means of this tool when you click on an element of the view, an image 

document associated to this element appears. Therefore it is necessary to define the 

path of the file by means of a field from the table of attributes of the theme. 
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3.17 Locator by Attribute 

 By means of the Locator by attribute button  or in the Locator by Attribute 

entry in the View menu, a dialog appears where we can zoom in to a specified area in 

the layer by specifying the value of a concrete attribute. 

 

 

 

 

 

3.18 Export to image 
In the “View" menu, the option "Export to" allows exporting the current view to an 

image format (bmp, jpg or png). 
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3.19 Export to raster 
 

 This tool will allow you to save an area of the view defined by a rectangle to 

a georeferenced raster file. 

 
When the tool is selected we can define a rectangle pressing the mouse button in 

the starting point, dragging and realising the button when we get the ending point. The 

Save as raster properties dialog will appear: 

 

 
 

The picture shows the dialog where appear the coordinates of the defined 

borders in the last step. This coordinates may be modified in the text fields to fine tuning 

the selection. 

 
In the central dialog’s area we can tune the printing scale and dpi. The size of the 

output image is automatically calculated according on these settings. It is important to 

adjust these parameters correctly. The most optimized values the best disk space and 

time usage we’ll have. 
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The “select” button will allow you to specify the destination file and its format. You 

can choose among the following formats: GeoTIF, JPEG2000 and jpeg on any system, 

and also ECW in linux (kernel 2.4 or above) systems. 

 

The “properties” button is used to tune some properties specific to the format in 

which we are willing to save. The default format is GeoTIFF. These are the options for 

GeoTIFF and JPG: 

 

Block size: The block size defines the amount of data read each time. The 

greater block size the faster compression speed but the more memory usage. By default 

it is set to 64, which is a adequate value for most systems. 

 
Photometric: [MINISBLACK / MINISWHITE / RGB / CMYK / YCBCR / CIELAB / 

ICCLAB / ITULAB]. Sets the photometric interpretation. Due to the input image is 3-band 

byte format, by default it is set to RGB. 

 

Interleave: [BAND, PIXEL]. The TIFF files have a band interleave by default, it is 

more efficient for some uses. Some applications only allow pixel level interleave. For 

those cases this option can be changed. 

 

Compression: [JPEG/LZW/PACKBITS/DEFLATE/NONE] Sets the compression 

factor. Normally, LZW is not available. By default, None is the default option. 

 

Generate tfw: If this option selected, a tfw file will be created with the 

georeferencing. 

 

For Jpeg2000 and ECW (if available) these are the options: 
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Compression factor: The compression factor determines the size of the 

resulting file, the greater compression, the smaller file size (and the worse image 

quality). 

 

Block size: The block size defines the amount of data read each time. It is 

possible to increase this value to speed up the compression but the memory 

consumption larger. By default it is set to 64, an adequate value for most systems. 

 

3.20 Raster Properties 
 

Right-clicking on a raster layer and selecting the raster properties option, appears 

a menu where we can do several things over a raster layer. 

 This menu has four tabs: 

- Info: containing a summary with general information about the raster. 

- Bands: gives to the user a set of tools for the modification of the way the 

bands are visualized. 

- Transparency: gives to the user a set of tools for the modification of the 

transparency levels applied to a raster. 

- Enhancement: gives to the user a tool to apply an enhancement to the raster. 

- Pansharpening: Gives to the user a new tool to increase the resolution of 

satellite images if the panchromatic band for those images is available. 

Here is a snapshot of the info tab. It is showing info about the raster: file path, 

number of bands, size (in pixel), file format, datatype and the geographical coordinates 

of the borders. 
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The next snapshot represents the bands tab: it shows the bands that compose 

the raster; you can move one band to any of the RBG bands. It is also possible to 

compose the raster using raster files for each of its bands. This is useful when working 

with Landsat-type images that each band is supplied in a different file. 

 

In addition to the transparency, there is another transparency support added to 

the transparency support in the v0.3 (since v0.4 called 'opacity') indicating 'occlusion' 
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percentage over the rest of the layers. The new transparency support let the set color 

groups be completely transparent. This is very useful, for example, to remove triangle-

refilling of pixels of satellite Ortho’s related with the satellite's flight. 

 

The enhancement tab allows enhancing the image contrast. This is required for 

visualizing 16 bits-per-band images.  
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The pansharpening is the tool used to increase the resolution of a satellite 

images. It requires the panchromatic band. 

 To use this tool the satellite image must be already loaded in the gvSIG’s view. 

In case that all the bands are contained in a unique file then the image will be loaded 

from the “Add layer” button. In case that every band has its own file, then each file has to 

be loaded from the “Add layer” -as in the other case- individually. 

Once loaded the first band, right-click on the layer’s entry of the TOC to see the 

context menu. Select the “Raster Properties” option. 
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The “Bands” tab in the “Raster properties” dialog let us to add more bands to the 

image, we will try to figure out the optimized visualization combination. In the same 

place, we will load the image corresponding to the panchromatic band but we will not 

select it for visualization. 

 

 
 

Once the bands are loaded then we are ready to go with the pansharpening. In 

the “Pansharpening” tab from the “Raster Properties” dialog, select the “Active 

pansharpening” check box to enable the tool. Select the panchromatic band from the 

band list. Finally, select the pansharpening algorithm to use. Two methods are available, 

brovey y HSL.  

 

The brovey algorithm performs an enhancement or reduction of brightness in the 

resulting image.  
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The HSL algorithm changes the coefficient added to the brightness of the 

panchromatic band before it is replaced in the destination image. This coefficient can 

take values within the 0.15-0.5 range; the resulting image brightness is also different for 

each value for this coefficient. 

 

Press the “Ok” or “Apply” button to apply the pansharpening and increase the 

resolution of your image. 
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3.21 Catalog 
 

The catalog service allows searching geographic information in the Internet. 

gvSIG offers a user-friendly interface that allows to find geodata and load them in the 

View whenever possible. 

 

1. Connecting to a server 
Before performing any search, it is necessary to connect to a catalog server. In 

order to start the wizard you need to open a search and press the button with the 

magnifying glass on a blank page. 

 

The catalogue dialog will pop up; enter there the connection info detailed bellow: 

1. The address of the server. 

2. The protocol of the server. In the case of the catalog it can be: 

0 Z39.50: General protocol of information retrieval. 

1 SRU/SRW: Variant of Z39.50. 

2 CSW: Catalog protocol defined by the OGC in the specification “Catalog 
Interface 2.0”. 

3. Database name: Only in the case of z39.50. If none is specified the default 
database will be used. 
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Press the “Connect” button and the application will try to connect to the server. If 

it is found and the server supports the protocol specified protocol a reply message will 

appear and the “Search” button will be enabled. In case of error, it will be displayed on 

the screen. 

2. Search 
 

Now you are ready to perform a search. To do this, you need to complete the 

fields of the following form, which can be visualized in a simplified, or in an advanced 

search (with more fields to perform the search). The fields used in the search are 

established by the server; so, they may not produce effects on some specific servers. 

 

 

 

 

 

 

 

 

 

 

If we change the zoom of the View, the change of coordinates will be reflected in 

this form. If you want to restrict the search area you will have to select the option 

“Restrict search area”. 

Once entered the values in the form press the button “Search” and wait for the 

search to conclude.  
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3. Visualization of the results 
If the search has been successful, a new window showing the search results 

pops up. Use the Previous and Next buttons to browse the results. 

 

 

 

 

 

 

 

 

 

On the left side of the screen you will see some information about the obtained 

metadata. If you want to see the complete metadata press the “Description” button. You 

can also see an image in miniature as long as the metadata has it. 

If the metadata has any associated geodata, the “Add Layer” button will be 

enabled. At the moment gvSIG can recognize associated resources such as WMS, WCS 

and PostGis tables, as well as Web pages and resources to download. If you press that 

button a new window is opened and it will show all the resources that the application has 

found. 
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If you click on a WMS, WCS or Postgis resource, the new layer will be loaded 

automatically in gvSIG. If the resource is a Webpage or download, the system’s default 

browser is opened.   

3.22 Nomenclator 
A nomenclator is a data set that establishes a relation between toponym and its 

geographical coordinates. gvSIG has a catalog client that allows to perform a search by 

toponyms and to center the View on the desired point. 

1. Connection to a server 
 

First you have to create a View and open it. A button with a magnifying glass on a 

red paper in the toolbar of gvSIG appears.  

 
 
 

 
This icon opens the wizard dialog that allows you to perform the search. The 

parameters to enter are: 

1 The address of the server. 

2 The protocol of the server. In the case of nomeclator it can be. 

1. WFS-G: General protocol of toponym search defined by the OGC. 

2. WFS: Although this protocol has been created with another purpose, we can 

use it to perform a search of toponyms as long as we have a text attribute in 

one of the tables. But this protocol also allows performing searches by any 

other field of a “Feature”, not necessarily a text attribute. 

3. ADL: Protocol specified by Alexandria Digital Library. 

4. IDEC/SOAP: Protocol that allows to use the nomenclator Web service of the 

Cartographic Institute of Catalonia (ICC). 
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After introducing all the parameters click on the button “Connect” and wait until 

the server is found and accepts the specified protocol, then the button “Search” will 

activate.  Otherwise an error message will be displayed.  

2. Search 
Now you are ready to search. Enter the values of your search in the form. You can see 

the simplified form or carry out an advanced search. 

 

 

 

 

 

 

 

 

If you change the zoom of the View, the change of coordinates will be reflected in 

this form. If you want to restrict the search area select the option “Restrict search area”.  

• Zoom to the result: centers the view to the selected result. 

• Delete previous searches: Removes all the texts in the view obtained from 

previous searches. 
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• Draw the result: Draws a point and text label in the position where the 

resulting toponym is placed. 

Once you have filled out the fields of the form press the button “Search “ and wait 

for the search to be completed. 

3. Visualization of the results 
A new window appears showing the results obtained. Use “Previous” and “Next” 

buttons to browse them. 

 

 

 

 

 

 

 

In order to finish, you only need to select the toponym you want and press the 

“Find” button. The gvSIG will center the View to the point where the toponym is located. 
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4. TABLES 
The tables are the documents that contain the alphanumeric information. The 

tables consist of rows or records (that represent each one of the elements of the 

database) and columns or fields (that define the different attributes of each element). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 Row or record: the representation of the different elements from the database. 

2 Column or field: the types of attributes that define each element. 

3 Cell: the intersection of a record and a field. A cell is the minimum element of 

work and it can always contain information. 

1 

2 

3 

4 
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4 Information of records: It informs you of the total number of elements 

(records) that the table contains. 

All the layers of vector information have their tables of attributes. Each graphic 

element of a given theme has its corresponding record in the table of attributes of this 

Theme. 

You can select elements in the table just by clicking the left button of the mouse. 

Using the control and CAPS keys you can select more than one record. 

4.1  Properties of tables 
You can access the Table Properties from the Project manager window  

 

 

 

 

 

 

 

 

 

 

 

 

From this window you can change the name of the Table and, basically, indicate 

the fields that you want to be visible (activating the checkboxs) or not. 
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4.2  Filters 
 

The tool "Filter" works in a similar way to Views. See (section  3.13 – Selection of 

elements by attributes). 

 

4.3  Statistics  
 

 The stats tool allows obtaining the usual statistics values over a selected 

field. 

 

It is possible to calculate the stats of the selected registers -if they are- or the 

total of the registers of a numeric field if there is no selection. 

4.4  Ascending Order 

 The ascending order tool allows sorting the records from the lowest to the 

highest value. 

4.5  Descending Order 
 

 The descending order tool allows sorting the records from the highest to the 

lowest value. 
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4.6  Relation 
 

 The relation tool allows relate two tables using a specified field. 

The first step is to choose the table to be related. 

 

And then choose the field used to do the relation operation. 

 

The next step is to select the destination table to be related with the first one. 
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And then select the field within the second table (it must match with the selected 

field of the first table) 

 

4.7  Link 
 

 The Link tool allows setting a link between tables using a common field. Any 

change made to one of these tables will be reflected in the other. 

First of all we must specify the table to be linked 

 

Then choose the field to be linked. 
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The second step is to select the destination table to be linked. 

 

And finally, select the field used to link with the first table. It must match with the 

selected field within the first table. 
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4.8 Creating a table from a JDBC data source 
It is possible to import the content of a PostgreSQL or MySQL data base to 

gvSIG. The data obtained will be processed by gvSIG like any other table in our current 

project. 

In order to create a new table with the data obtained from a source of external 

JDBC data you have to do the following: in the menu Project click on adding a new table. 

The following menu will be displayed, and you can then configure the parameters for the 

connection: 

 

If the information entered is correct and you have the required permissions, a 

new table will be generated in gvSIG with the information contained in the original JDBC 

table: 
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This table has the characteristics of any other gvSIG table formed from any other 

data source, and you will be able to perform the same operations on it. 

4.9 Creating a table from a CSV file 
gvSIG Version 0.5 can read information from a file with plain text separated by 

points and commas. 

 

In order to perform this operation you have to select the option "Create new 

Table" from the Project menu. Once in this menu, select the option of data source file 

and the dialogue below will be displayed, in which you can indicate that you want to 

access to a CSV file: 
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When you check the option of CSV file, and click on Open, the following dialogue 

box will appear. 
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If you click on Accept, the new table will appear, in which you can operate in the 

same way as you do with any other table from any other source of data. 
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5. MAPS 
The map documents allow to design and combine in a page all the elements that 

you want to appear in a printed map. 

 

 

 

 

 

 

 

 

 

The maps appear in a window like a sheet with a grid of dots, used as aid for the 

drawing, and two rulers (vertical and horizontal). 

This grid does not appear printed and is defined by selecting the option 

"Properties" within the "Map" menu. 
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1 If you activate the checkbox, the grid is activated. This means that any element 

that is inserted in the map will be adjusted  to the grid. 

2 The separation between the different points that compose the grid is defined 

by means of the options of vertical and horizontal spacing. 

3 If you activate the checkbox, the ruler activates. The ruler is used as a help 

element to the drawing. 

5.1 Configure page 
 

In the menu "Map" select the option "Configure page". By means of this tool you 

can define the work space, that is, the size and properties of the page where you are 

going to perform the composition of your map. Another option is to click on the 

"Configure page" button of the Toolbar.  

1 

2 

3 
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1 Paper: it allows to define the origin and the size of the paper where the map is 

going to be printed. We can select a standard size or one defined by the user. 

2 Orientation: once the size of the paper is defined, proceed to define its 

orientation, horizontal or vertical. 

3 Margins: it allows to define the four margins of the sheet. The ruler adjusts to 

the margins of the page. 

5.2 Insert elements 
It is possible to add the following cartographic elements to you map: 

• Views: 

• Images: 

• Scale bars  

• Legends: 

2 

1 

3 
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• Graphic objects  

• North arrows 

 

Many of the cartographic elements are intimately related to the View document, 

so that when making changes, these are shown in the map (changes in zoom, 

movements, modification of legends, organization of layers, etc.). 

5.2.1 View 

 Click on the “Insert view" button of the Toolbar to insert a View in the Map. 

Place the mouse pointer, click the left button, in one of the ends of the rectangle that 

defines the space to occupy by the view and drag and drop in the opposite end. 

A dialog box appears in which you can define the properties of the View element 

you have just inserted. 

 

 

2 

1 

3 

4 

5 
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1 View: select, in case of having more than one, the View that you want to insert. 

2 Scale: select one of the following three types of scale: 

• Automatic. 

• Keep visualization scale. 

• User defined: that allows to enter a given scale. If you select this 

option, choose 3 in the scale factor. 

4 Quality: It has an effect on the visualization; it can be print quality or draft. 

5 Rotation: You can apply a rotation to an element in the map.  

5.2.2 Image 

 Tool that allows to insert an Image in the Map. 

The dialog box shown is the following: 

 

 

2 
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Click the examine button you can select the path where the image file to insert is 

located. You can insert jpg, gif and png. 

Since v0.4, it is possible to add vector files in SVG format to the layout. 

5.2.3 Scale 

 Tool to insert a scale (related to a view) in the Map.  

The dialog box of the scale element is the following:  

 

 

1 

2 

4 

3 

5 

6 

2 
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1 View: select, if there are more than one, the View to which the scale that you 

want to insert is related. 

2 Style: select the type of scale to insert, numerical or graphical. 

3 Units: define the units of the graphic scale (meters, km, etc.). 

4, 5 and 6 Intervals: select the number of intervals, what each one of them 

represents and the number of divisions to the left of 0. 

5.2.4 Legend 

 Tool to insert a legend in the map. The legend represents the visible 

Themes of the Table of contents of the selected view. 

 

 

 

5.2.5 Graphics 
You can insert the following types of graphical elements: 

• Points 

• Rectangles  

• Circles  
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All these elements can be inserted from "Insert" of the "Map" menu.  

 

 

 

The method to draw these elements is similar, click with the mouse on each one 

of the points that define the element. Texts are a special case.  

 Texts, which can also be inserted by clicking the corresponding button of 

the Toolbar, are defined in the dialog box that appears. 
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1 In this box you type the text to insert. 

2 Align: select the type of alignment (left, centered or right). 

3 Font: Select the font. 

4 Rotation angle: Specify the angle of the texts, with respect to the horizontal. 

5 Frame: It is possible to set a surrounding frame to the text. 

6 Frame title: You could set a title to the text field. Combined with a frame will 

allow you to produce professional form-shape documents. 

1 

2 
3 

4 

5 

6 
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5.2.6 North Symbol  

Click on the “Insert North" button of the Toolbar to insert a North symbol in the 

Map. Place the mouse pointer, with the left button pressed, in one of the ends of the 

rectangle that defines the space to occupy by the symbol and drag and drop in the 

opposite end. 

A dialog box appears where you can select from several predefined models of 

north. 

 

It is possible to add new symbols by simply copying them in the folder 

\northimages inside gvSIG. 

The acceptable format for the North symbols is SVG (Scalable Vector Graphics). 

In order to add a new North symbol, you have to create it with an external 

application to gvSIG (like Inkscape). In addition, to ensure that gvSIG handles correctly 

the new North symbol it is advisable to be performed on the basis of some of those 

suggested in gvSIG by default. 
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5.3  Graphics 
You can perform many actions with graphics, apart from the basic ones of 

moving or changing its size. Most of the graphics editing tools are in the "Graphs" menu 

or in the buttons on the right of the Toolbar. By clicking on the right button of the mouse 

a floating menu appears with some of the most frequently used tools.  

 

5.3.1 Align 
This command can be found in the menu "Graphics". With this you can align the 

elements of the Map selected. There is a large variety of options to personalize the 

distribution of the elements, as you can see in the dialog box, that allows to select the 

action to perform. 

 

 
 
5.3.2 Group / Ungroup 

 By means of these two buttons of the Toolbar (or in the menu 

"Graphics") you can group several elements in one single one, or ungroup an existing 

grouping. 

If you group several graphs in one you can perform some actions more easily, 

like scrolls or changes of size. 
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5.3.3 Simplify 
In the menu "Graphics" the tool "Simplify" allows to convert simple elements into 

complex graphical organizations, like legends or graphic scales. Once these elements 

are simplified they lose their connection with the View. 

 
5.3.4 Order of visualization 

 By means of these two buttons you can change the order of 

visualization of the selected elements, placing them above or below others.  

 

5.4  Graphic line 

 This tool draws a border around the element or elements selected. 

The options appear in the following dialog box: 

 

5.5  Size and position 

 This tool opens a dialog box that allows you to specify with detail the size 

and the position of the selected element.  
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5.6 Printing 

 This option opens the Print dialog box, in which you can select the options 

related (select printer, quality, etc.)  
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5.7  Map navigation tools 

  By means of these tools you can move 

around the map page, by zooming in and out. 

 Zoom in: zooms in towards the centered page in the position or area 

defined by the user. 

 Zoom out: zooms out the centered page in the position area defined by the 

user. 

 Scroll: it allows you to move around the page. 

 Full Zoom: it zooms to the full size of the page. 

 1:1 Scale zoom: it zooms to the "actual" size of the configured page. 

 Zoom in: it zooms in towards the centered page. 

 Zoom out: it zooms out towards the outside of the centered page. 

 

5.8  View navigation tools  

 With this set of tools you can navigate through a view in the 

same way as if you were in the document "View". Thus, you can define the exact area 

that you would like to appear in your map without having to switch documents. 

 Full zoom to View: It zooms to the extension that the themes of the view 

define. 
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 Zoom in on View: it enlarges a given area of the View. 

 Zoom out on View: reduces a given area of the View. 

 Scroll: it allows you to move around the View.  

5.9  Export to PDF tool 
 

 By means of this tool any layout composition can be exported to a Portable 

Document Format (PDF) file. 

5.10 Templates 
This new version of gvSIG also includes the feature to save a Map configuration 

as a template so that it can be used at any other moment with different data sources. 

From the following Map we can save the distribution and properties of its 

elements: 
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If you click on File, and then Save as Template, you can generate a .gvt file that 

can be recovered under different circumstances and will allow you to reconstruct the 

configuration of the Map. 

 

When you finish the current project and start a new one, if you click on File, and 

then Open Template: 

 

The following dialogue box will open, and you will be able to choose the template 

file you want to use: 
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Therefore, you have managed to reconstruct the configuration of the Map saved 

as template: 
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